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Images, Clips, Texts and Effects

First Steps towards a Fantastic Animation  

Video Compositing Video compositing means the simultaneous overlapping of several
images, graphics, clips and audio files in separate tracks. Typical
functions include layering, 2D and 3D effects, color correction, keying
functions (chroma key and others) as well as masking. 

Our Aim  You already know how to set up MoviePack, how to edit clips and how
to create effective transitions.

You are about to learn how to apply effects to clips and images. In
particular we will concentrate on:

● Positioning and moving objects 

● Scaling objects

● Rotating objects

● Applying effects to objects

In a few detailed steps, we are going to teach you how to successfully
create your own animation. 

L:\Movieack\ 
Comic_Compositing.tif
OHNE „COMPOSITING' 
DARSTELLEN!!!

Tut_Compositing_001_X.tif
Tut_Compositing.M3W 
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I Please read the ’Tutorial - The Interface’ booklet before
beginning ’Video Editing’ as the MoviePack interface
described therein is needed for the following tutorial. A new
animation is also needed in the Canvas window.

Preparing New Animati-
ons  

Each new animation has to be set up properly. The size of the animation
should be 240 x 320 pixels with 25 frames per second set against a
white background.

u Close any existing animations with the Close command from
the File menu (shortcut Ctrl+F4).

Save the animation under a suitable name in a suitable folder. 

u Click the  New Animation icon in the MoviePack icon bar.

u In the Animation Setup dialog box select PAL (or NTSC) in the tab
Time. 

u In the Page tab select Size Multimedia Medium, 320 x 240. 

u Click on Background Color.

u In the Choose Color dialog box set the Brightness slider to 100 in
HSB or in the chromaticity diagram drag the small slider to
the white area.

I In the Schemes tab you can save the settings under ’PAL-
Medium-White’ and then all new animations will be loaded
with these settings in future. 

Adjust the new Canvas, ’Animation x’, to full size by dragging the corners
of the window with the mouse.

I It is even easier to create a new animation by loading the
’Tut_1152x864.M3W’ project from the ’Samples’ folder.

u From the File menu, select the Open Project command.

u In the Open Project dialog box, select the ’Samples’ folder and
then the ’Tut_1152x864.M3W’ project.
Images, Clips, Texts and Effects
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Procedural Images

Large Choice  MoviePack generates graphic objects such as Checker Board, Color
Gradient, Color Ramp, Random Generator and numerous others. These objects
are used for compositing and can be animated using the parameters in
the Effect Box. After insertion into the tracks Video1, Video2, generated
images are square and smaller than the page.

For our little animation we are going to use the Random Generator object
as a moving background.

u In the Timeline, set the Timeslider to 0:00:00:00.

u In the Browser open the Objects folder. 

u Double-click the All Objects folder.

u Scroll down until the icon for the Random Generator is visible.

u Drag the Random Generator into the track Video 1 in the Timeline,
so that the black object bar begins at 0:00:00:00. 

The square surface of the Random Generator is automatically centered in
the Canvas but does not fill the entire workspace. 

Zooming If the Canvas display is too big or too small, the zoom button can be used
to either enlarge or reduce it.

Tut_Compositing_Time
line_001_G.tif
Tut_Compositing_001.
M3W 
Manual Tutorial Reference Effects
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u Click on the zoom button and select another scale,
for example, 100 % instead of 167 %.   

The Canvas display can be shrunk or enlarged gradually using the two
magnifying glasses  (zoom buttons). 

I The size of the Canvas (320 x 240 pixels) is not affected by
the scaling of the display. This can be altered only in the Scene
Setup dialog box (File - Scene Setup).

Outside the actual Canvas there is enough space for editing. 

As the background, the Random Generator should fill the entire Canvas area.
To fill the remaining black area, the Random Generator has to be enlarged. 

There are two ways to enlarge or shrink (scale) images and videos in
MoviePack:

● Scaling in the Canvas 

● Scaling in the Effect Box

Object Object Borders Scaling Handles
(square) (8 square points)

Zoom buttons to enlarge or shrink the 
Canvas

Button to center the Canvas

Sliders and scroll 
bars to move the 
Canvas

Canvas

Tut_Compositing_Canva
s_002_X.tif
Tut_Compositing_001.
M3W 
Procedural Images
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Scaling in the Canvas In the Canvas, if the corners are represented by small squares an object
can be scaled using the four corners of the object.

u Position the mouse over one of the square corners in the
Canvas. 

The pointer is transformed into a scale symbol. Click the corner and the
entire object can be proportionally enlarged or shrunk subject to the
existing aspect ratios.

The Various Mouse Poin-
ters used for Scaling 

Depending on where the pointer is positioned, for example next to an
object, directly over an object or handle on a horizontal or vertical
border, it changes into a different symbol with specific manipulation
functions.

The normal select symbol: An object beneath this pointer can
be activated by a simple click.

Move symbol: The object beneath this pointer can be moved.

Scale symbol: The object beneath this pointer can be
proportionally enlarged and shrunk.

Stretch symbol: The object beneath this pointer can be non-
proportionally stretched and compressed.

Place the pointer on various areas of the Canvas and watch how it
changes.

u In the Canvas, position the pointer over a square corner. 

u Click the corner and drag it inwards or outwards. 

For the time being, the Random Generator will remain the same size, while
the enlarged or reduced object borders with the 8 handles have
changed size. 
Manual Tutorial Reference Effects
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Scaling in the Effect Box  The Effect Box icon bar, under the Effect Box title bar, contains two icons.
The first icon represents the object Random Generator, the second icon
represents all the basic Transformations that can be applied to an object,
such as scaling, rotating, alteration of rotation center and focusing. 

u In the Effect Box, click the Transformations icon. 

u In Transformations, click the Scale tab. 

In the Scale tab, the default slider
settings for both the Scale and Stretch
parameters are set to 1.  

I If an object is bigger than the Canvas, it is automatically
scaled and displayed, so that both the height and width are
visible. Naturally the original aspect ratio Width : Height is
retained (Stretch = 1) and the parameter Scale adopts a value
of less than 1.

All sliders are manipulated using the mouse.

u In the Effect Box, drag the Scale slider to the right until the
Random Generator is bigger than the Canvas.

The size of the image in the Canvas (identifiable thanks to the symbolic
object borders) and the scale factor to the right of the slider, are
changed simultaneously.

I The scale factor can also be entered using the keyboard.

u In the Effect Box, overwrite the scale factor, for example,
, with 2.5 using the keyboard.

 Random
Generator

Transformations

Tut_Compositing_Transforma
tions_002_E.tif 
Tut_Compositing_001.M3W 
Procedural Images
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I Whether the decimal symbol is a comma or a dot will
depend on your Windows setting (Start - Settings - Control Panel-
Regional Settings- Tab Number - Decimal symbol).

The scale factor can be entered using the plus and minus buttons to the
right-hand side of the scale .

A scale factor of 2.5 means the entire background of the Canvas is filled.
Let’s take a quick look at our animated background in the Preview
window.

u In the Preview, press Play.

We can see a 3 second preview. At the beginning the background is
the desired size, but as the time passes the image becomes smaller.

I If we move the Timeslider to another point in time, we can
see the changes in the Canvas.

u In the Timeline, click the Timeslider and drag it back and forth.  

The Various Mouse Poin-
ters in the Timeline 

The mouse pointer is displayed in several different ways in
the Timeline. 

When the pointer is positioned over the Timeslider, it
automatically changes from a hand or pointer into a move
symbol, meaning the Timeslider can be moved. 

The reason for the background becoming smaller is that the object has
a constant scale factor of 1.0 over the entire time span (0:00:00:00 to

Timeslider
Tut_Compositing_Timeline_0
01_G.tif 
Tut_Compositing_001.M3W 
Manual Tutorial Reference Effects
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0:00:02:24), and we have manually changed the scale from 1.0 to 2.5
at 0:00:00:00.

Changes at a Certain Point 
in Time

Generally, every change to an object or effect parameter is applied
only at the point of time when the change was made. 

The following example clearly explains this MoviePack principle:

The Random Generator has been inserted into the animation. The scale
value is 1 at both the beginning (0:00:00:00) and the end
(0:00:02:24) of the object, as well as at every point of time in-between.
If the value is altered to 2 at a certain point in time, for example,
0:00:01:00, the frames in the time span between 0:00:00:00 and
0:00:01:00 will get increasingly bigger in size, while the frames in the
time span between 0:00:01:01 and 0:00:02:24 will get increasingly
smaller.

The Random Generator is magnified for 1 second from frame to frame
linearly, so that afterwards it is scaled down to its original size.

As the change in size of the object in our example is regular, yet the
temporal spacing is different (1s for the enlargement and 2s for the
reduction), we see a quick increase in size then a slow reduction in size. 

I Different time spans and parameter changes result in various
speeds.

I In principle, every object and effect parameter can be
manually changed for each frame.

Equalizing ChangesThe size of the background should remain constant throughout.

u In the Timeline set the Timeslider to 0:00:00:00.

u In the Effect Box, enter the value 2.5 in Scale.

u In the Timeline, set the Timeslider to 0:00:02:24.

u In the Effect Box, enter the value 2.5 in Scale.

The size of the background remains constant from the beginning and to
the end of the animation. In the Preview a motionless colored
background is visible. 
Procedural Images
Video Compositing TUT 11Manual Tutorial Reference Effects
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Unifying Keyframes It is even easier to equalize different parameter values with the Unify
Keyframes function. To illustrate how this works we have to first undo the
last step. 

u From the Edit menu select Undo (shortcut Ctrl+Z). 

In the Effect Box, the Scale value automatically goes back to 1.0 from 2.5. 

The parameter value of the Random Generator at 0:00:00:00 should be
constant throughout.

u In the Timeline set the Timeslider to 0:00:00:00.

u From the Object menu select the Unify... command (shortcut
Ctrl+U). 

In the dialog box Unify Keyframes, a chosen object, the effect to be
applied to it or one of the effect’s parameters (channel) can be selected
from the three top lines.  

Choice 
of an object,
of an effect and 
of a parameter
Manual Tutorial Reference Effects
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If for example the effect Transformations is selected, all parameters of the
Transformations (Scale, Stretch, Position, Rotation, ...) remain constant in
the animation.

If the size of the object is to remain constant, select the Transformations
effect and Scale channel. The values for Position, Stretch, Rotation, ... are not
unified.

u In the Unify Keyframes dialog box select the Transformations effect. 

u Click the Unify Keyframes button.

In the Preview a motionless background is visible. 

Rotating in the Effect Box  Now we are going to bring the background to life.

u In the Effect Box, activate Transformations.

u In Transformations, click the Rotate tab.
Tut_Compositing_Transformat
ions_003_E.tif 
Tut_Compositing_001.M3W 
Procedural Images
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In the Effect Box, there are 6 numerical input boxes for the rotation on the
3 axes. There is a circular slider around the globe which allows rotation
on the Z axis. 

I The X axis is horizontal, Y axis is vertical and the Z axis is
perpendicular to the XY plane.

Rotation in MoviePack is very simple. The Globe itself is a slider for the
rotation on the X axis and Y axis. As with the slider for the Z axis, it can
be rotated using the mouse.

Vertical Y axis

Horizontal X axis

Perpendicular Z axis

Complete Rotation

Globe

Angle

Slider (Z axis)

Slider (X & Y axes)

X axis

Y axis
Z axis
Manual Tutorial Reference Effects
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The image is simultaneously rotated in the Canvas. In the numerical input
fields in the Effect Box the rotation is displayed for both full rotations in
the left-hand field and for part rotations in the angle field (right-hand
field).

I To rotate the image around the X or Y axes, click on the Globe
and move it in any direction.

u In the Timeline, set the Timeslider to 0:00:02:24.

u In the Effect Box, rotate the Globe up and down or left and right.

The results are visible in the running preview and in the Canvas.

In this tab of the Effect Box all values can be entered numerically using the
keyboard. 

I Using the Tab key on the keyboard, you can switch from one
input field to the next.

u In the Effect Box, set all values to 0. 

The background should be rotating clockwise. If you have already
experimented with the sliders, you can delete all values and start over.

u In the Effect Box, set all values to 0. 

u In the Effect Box, rotate the Globe once in a full circle
beginning at the bottom. 

The Z value (complete rotation) is set to -1. 

We can see the background rotating in the Preview.

I To rotate in the opposite direction either rotate the globe in
the opposite direction or simply enter a negative value for the
rotations and angles.
Procedural Images
Video Compositing TUT 15Manual Tutorial Reference Effects
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Moving Foreground A second procedural image, the Color Ramp, is now going to play a part
in the foreground of our little animation.

u In the Timeline, set the Timeslider to 0:00:00:00.

u In the Browser, drag the Color Ramp object from the All Objects
folder into the Timeline, ensuring that the black object bar is
positioned over the Video 1 track and that it begins at
0:00:00:00 . 

The Color Ramp has been inserted into a new track above the Video1 track.  

The square surface of Color Ramp is centered in the Canvas. 

The Color Ramp colors can be
animated in the Effect Box just like
the Random Generator colors. 

The colors in the four corners of
the Color Ramp are shown in the
tabs Top Colors and Bottom Colors.

Changes to the HSB or RGB
color models can be made
using the sliders or in the
numeric input fields.

Tut_Compositing_Timeline_0
02_G.tif
Tut_Compositing_001.M3W 

Tut_Compositing_ColorRamp
_001_E.tif 
Tut_Compositing_001.M3W 
Manual Tutorial Reference Effects
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Changing Appearances 
using Effects 

Now we are going to introduce you to the MoviePack effects. Effects
change the behavior and appearance of an object.

u In the Timeline, set the Timeslider to 0:00:00:00.

u In the Browser, select the Effects folder. 

u Double-click All Effects in the Effects folder. 

u Scroll down using the scroll bar on the right-hand side until
the Transparent Border effect is visible.

u Drag the Transparent Border onto the Color Ramp in the Timeline.

In the icon bar of the Effect Box the icon for the active effect appears next
to the Transformations. 

Other effects can be applied to the object in the same way. 

Sliders and numeric entry fields control the parameters. If you want a
stronger effect, the same effect can be applied several times. 

Switching Objects On/Off Looking at the Canvas, the Color Ramp’s transparent border is not clearly
visible because of the colored background. The background has to be
made invisible in either the Canvas or the Preview.

Transparent Border icon

Border Width slider

Equal Borders switch

Tut_Compositing_Transparent
Border_001_E.tif 
Tut_Compositing_001.M3W 
Procedural Images
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In the Timeline there are two buttons which make objects visible or
invisible.

The first button (cross on the monitor) next to the name of the
track, in this example Video 1, makes the visible object
invisible in the Canvas only. Objects that were hidden become
visible.  

The third button (cross on the render icon) makes the visible
object invisible in the Preview only. Objects that were hidden
become visible. 

I Another click on the respective button makes the object
visible again.

u In the Timeline, activate and deactivate each button in turn
and observe the results in the Preview and the Canvas.

Protecting Objects Against 
Changes 

Until now changes could be made to an object.

Activating the second button in the Timeline, the ’Padlock’,
protects the object from changes. This means:  

● Changes to the object or the effect paramters are not
possible using the sliders or numeric entry fields. 

● In the Effect Box, parameter changes of individual effects are
still visible when the object is locked.

● The object can be activated in both the Timeline and in the
Canvas by a simple mouse click as before but it cannot be
moved. The object borders in the Canvas are a different color. 

Object invisible in the Canvas 

ii Object invisible in the Preview

Tut_Compositing_Timeline_0
03_G.tif 
Tut_Compositing_001.M3W 
Manual Tutorial Reference Effects
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I The color of the object borders can be altered in the Objects
tab in the Animation Setup dialog box. 

u Right-click in the Canvas. 

u Select the Animation Setup
command from the context menu. 

In the Animation Setup dialog box other
settings can be altered besides the frame rate in the Time tab and the
size in the Page tab.   

For the time being we are not going to change the background, so the
object can remain locked. For this exercise it does not matter whether
the object is visible or not.

Rotating in the Canvas As with scaling, an object can be rotated in both the Effect Box and the
Canvas.

u Click the object in the Canvas.

The object and the object borders with the 8 handles are displayed in
the Canvas. Remember that positioning the mouse over one of the
handles changes the pointer into a different symbol and the object can
be stretched and compressed using the handles on the horizontal and
vertical borders, and scaled using the corner handles.

tut_canvas_context_menu_001
_E.TIF
tut_animation_setup_004_E.TI
F

Procedural Images
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I If the object borders are not shown in the Canvas, click the
object once to make them visible.

Click the object a second time and the square handles turn into circular
handles. 

Various Pointers for Rotati-
on 

Depending on where the pointer is positioned, for example next to an
object, directly over an object or handle on a horizontal or vertical
border, it changes into a different symbol with specific manipulation
functions.

The normal select symbol: An object beneath this pointer can
be activated by a single click.

Move symbol: The object beneath this pointer can be moved.

Rotation symbol: The object beneath this pointer can be
rotated on an axis.

Position the pointer on the different areas of the Canvas and see how it
changes.

u In the Timeline, set the Timeslider to 0:00:00:00.

u Click the object once or twice in the Canvas so that the circular
handles are visible. 
Manual Tutorial Reference Effects
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u In the Canvas, click on a circular handle on a vertical border
and rotate the object 180 degrees to the other side of the
object.  

While rotating the object border on the vertical axis, the object itself
remains in place. The rotation axis and the angle of rotation are shown
next to the pointer. After releasing the mouse, the object is rotated in
both the Canvas and the Preview. The new values are entered into the
appropriate rotation and degree input fields in the Effect Box. 

The object can be rotated on all three axes using the handles:

● Rotation on the horizontal X axis. Either one of the circular
handles in the center of the horizontal border lines.

● Rotation on the vertical Y axis. Either one of the circular
handles in the center of the vertical border lines.

● Rotation on the perpendicular Z axis. Any of the circular
handles at the 4 corners of the object.

It is irrelevant which of the two or four handles are used to rotate the
object. 

Tut_Compositing_Canvas_003
_X.tif
Tut_Compositing_001.M3W 
Procedural Images
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Rotating on Several Axes  In MoviePack, each object can be rotated on several axes
simultaneously.

u In the Timeline, set the Timeslider to 0:00:01:12 (the middle
of the animation).

The Color Ramp rotates 90 degrees in the Canvas and the handles are now
difficult to see and to grasp, therefore we have to rotate the object in
the Effect Box.

u In the Effect Box, drag the handle of the slider for Z axis
downwards to the other side of the Globe (180 degree
rotation).

Take a look at the Preview with a visible background and you will see
that both objects are contrarotating.

Title and Text

In MoviePack, it is not only graphics, images and videos that can be
animated. Titles and texts supply additional information and
occasionally contain the fundamental content of a clip, skillfully
wrapped up in an animation. 

MoviePack contains objects for displaying textual information.

The Titler is a particularly effective way of displaying textual
information as a title. The text can be altered by many
parameters in the Effect Box.

The Text String object is suitable for simple texts.

With Marquee, longer texts can run across the screen in single
lines, like stock market or news tickers.

Roll allows several lines of text to roll over the screen like film
credits. 
Manual Tutorial Reference Effects
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Object Titler  We are now going to introduce the Titler into the animation. As with
other objects, it can be found under the All Objects tab in the Browser.

u In the Timeline, set the Timeslider to 0:00:00:00.

u In the Browser, drag the Titler from the All Objects folder into the
the Video 2 track in the Timeline, ensuring that the black object
bar begins at 0:00:00:00.

There are now three objects in three different tracks in the Timeline.   
Tut_Compositing_Timeline_0
04_G.tif
Tut_Compositing_001.M3W 
Title and Text
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In the Titler effect box there are
many parameters in different
tabs. In the first tab, Text, the title
is shown in a small preview
window. The text can be entered,
the font can be selected and
some text characteristics can be
altered.   

From all the options available we
are going to use only one for the
moment:

u In the text entry line
overwrite the existing
’MoviePack’ text with
’Flying Letters’.

In the Preview, the background
and the Color Ramp are rotating
behind the title.  

Flying Titles  The title can also be brought to life. Imagine your title flying from the
bottom left behind the Color Ramp to the top right of the screen.

u In the Timeline, set the Timeslider to 0:00:01:12 (the middle
of the animation). 

u In the Timeline, click the Titler. 

Tut_Compositing_Titler_001_
E.tif 
Tut_Compositing_001.M3W 

Tut_Compositing_Preview_00
1_E.tif 
Tut_Compositing_001.M3W 
Manual Tutorial Reference Effects
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u In the Effect Box, click Transformations. 

u In Transformations, click the Scale tab. 

u Set Scale to 0.01 seconds.

The titler increases then decreases in size in the Preview. 

u In the Timeline, set the Timeslider to 0:00:00:00 (at the
beginning of the animation).

u In the Canvas, click the center of the Titler and drag it towards
the bottom left-hand corner (Position -80 : -40). 

u Click the Titler a second time to enable rotation.

u Rotate the Titler on the Y axis about 60 degrees using the
vertical handle on the right (Rotate Y: 60 ).

The following picture should appear in the Canvas:  

Now we are going to enter the same manipulations but with the
negative values at the end of the animation.

u In the Timeline, set the Timeslider to 0:00:02:24 (at the end of
the animation).

u In the Canvas, click the center of the Titler and drag it towards
the top right-hand corner (Position 80 : 40).

Tut_Compositing_Canvas_004
_X.tif
Tut_Compositing_001.M3W 
Title and Text
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u Rotate the Titler on the Y axis about -60 degrees using the
vertical handle on the left (Rotate Y: -60 ).

The following picture should appear in the Canvas:  

The Animation in the 
Preview 

Finally, let’s take a look at our little animation in the Preview:  

The MoviePack generated Random Generator rotates slowly in the
background, while the Color Ramp rotates on several axes in front of it.
The title flies through time and space in the foreground towing a
shadow in its wake. 

Tut_Compositing_Canvas_005
_X.tif
Tut_Compositing_001.M3W 

Preview of the beginning and end of the animation.

Tut_Compositing_Preview_00
2_E.tif 
Tut_Compositing_Preview_00
3_E.tif
Tut_Compositing_001.M3W 
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This animation is saved under ’Tut_Compositing.M3’ (the
project under ’Tut_Compositing.M3W’) in the ’Samples’
folder and can be used for further experiments.   

Have Fun Experimenting!  Save the animation under a suitable name and experiment a bit more
to get better accquainted with the object and effect parameters. The
Titler has endless possibilities, from the many effects (besides the
Transformations) we have only used the Transparent Border - there is simply
not enough space in this tutorial to describe all the available effects. 

The objects used in the animation were generated by MoviePack but
you can swap them for other objects or for your own images and
videos. The MoviePack CD also offers a huge selection of images and
videos. 

Tut_Compositing.M3
Tut_Compositing.M3W

Comic_Framy03.tif 
Title and Text
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